
Through this lecture students will be able to:

3rd Year Dent. Tech. Dept.10/12/2022

1

1



Lecture - 1:  3rd Year Dent. Tech. Dept.

Microsoft Office 2019
Mainly it include the three popular 

applications

MS Office include many 

applications
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Office applications
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Microsoft applications

Microsoft applications are comprised
of mainly the Office suite of
applications that support various
productivity needs on both Microsoft
Windows and Mac OS operating
systems.

تطبيقاتمجموعةمنأساسيبشكلMicrosoftتطبيقاتتتكون

Officeتشغيلأنظمةعلىالمختلفةالإنتاجيةالاحتياجاتتدعمالتي:

Microsoft Windows ,Mac OS
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MS Excel Basics 

1. Identify general needed  
shortcuts

2. Explore MS excel window 

3. Navigate between 
different cells

4. Manage the workbook 

5. Formatting for cells and 
sheets (paper)

(The Excel)المهمةالتطبيقاتبأحدأولانبدأ

 :منالطلبةسيتمكن

المطلوبةٍ العامةالاختصاراتمعرفة1.

Shortcut 
اكسلمايكروسوفتنافذةمعالتعامل2.

ةالمختلفالخلايابينالتنقلكيفية3.

 Workbookالمصنفإدارة4.

والأوراقالخلاياتنسيق5.

10/12/2022 53rd Year Dent. Tech. Dept.



1. Click the Start button.
2. Locate the application you want to pin     

to the taskbar and right-click on it.
3. In the menu that appears, hover your 

cursor over "More"
4. Click on "Pin to taskbar"

How to pin Microsoft Excel to taskbar?
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1. Click on Microsoft Excel.
2. Select desired option

(NEW = Ctrl +N
or   OPEN= Ctrl +O )

How to start Microsoft Excel?
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Keyboard Shortcuts 
 General :

 New Workbook (Ctrl+N)

 Open a Workbook (Ctrl+O)

 Save a Workbook (Ctrl+S)

 Print a Workbook  (Ctrl+P)

 Close a Workbook (Ctrl+W)

 Undo (Ctrl+Z)

 Redo (Ctrl+Y)
 Switch between apps (Alt + Tab)

 Editing:

 Cut   (Ctrl+X)

 Copy (Ctrl+C)

 Paste (Ctrl+V)
3rd Year Dent. Tech. Dept.

10/12/2022 8



Learning MS Excel Basics: Explore Window 
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The Ribbon

Microsoft Excel Ribbon is the
row of tabs and icons at the top
of the Excel window. It allows
you to quickly find and use
commands for completing a
certain task. It looks like a kind
of complex Toolbar.
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The Home contain the following Icon
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1. Clipboard (CUT, COPY, PASTE)  
2. Font
3. Alignment  
4. Number 
5. Style
6. Cell 
7. Editing

Ribbon contain the following Icon
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Font (type and  size)

Style (Underline, Italics, and Bold) or (Ctrl+U), (Ctrl+I),(Ctrl+B)

Colours( fill colours)
Borders:

Font Attributes
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Learning MS Excel Basics: Entering Value

This is the default sheet
To enter data: Select the cell, Start typing
Important tips:

1. To move to the next column (press Tab key)
2. To move to the next row (press Enter key)

3. To start new line in the same Column(press 
Alt + Enter) you can use the arrows key to 
select the desired cell.

cell

10/12/2022
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Saving Workbook:

• File > save as > specify the location and modify the 
file’s name if required.

Closing Workbook: CTRL+W or

CTRL+F4

Open workbook:      CTRL+O

Learning MS Excel Basics:

3rd Year Dent. Tech. Dept.10/12/2022
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For Worksheets we can:
1. Insert one or more Worksheet
2.Rename it
3.Change its Tab color
4.Rearrange them in any required order
5.Delete unrequired one
6.Duplicate (copy) or move it before / after 

any Worksheet or at the end
7.Hid and Unhide certain Worksheet.  

Managing worksheets 

10/12/2022
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MS Excel Basics 

1. Identify general needed  shortcuts

2.Explore MS excel window 

3.Navigate between different cells

4.Manage the workbook 

5. Formatting for cells and sheets
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Getting started

10/12/2022 3rd Year Dent. Tech. Dept. 18

Cell : can 
contain a 

Number, 
Logic Date,

text or 
formula

Worksheet:
a single

spreadsheet that 
contains cells
organized by 

rows and 
columns



Saving Workbook:

•File > save as > specify the location 
and modify the file’s name if 
required.

Closing Workbook: CTRL+W

Open workbook: CTRL+O

Learning MS Excel Basics:
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Managing worksheets 

1. Identify how to manage worksheet

2.Editing worksheets 

10/12/2022 3rd Year Dent. Tech. Dept. 20



oActivate the cell and add data
o Insert formula:

Formula in Excel ( Insert data )

10/12/2022 21



Editing Worksheet:
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Editing Worksheet: Sorting Cells

• Sorting in ascending , descending numeric order
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Creating new Worksheet:
• How many sheet are provided in the workbook by default?
• Now in order to add more sheets:
▫ Right-click on sheet tabs 
▫ Select Insert
▫ An insert dialog will display with selected worksheet  

Copy Worksheet:
• Right click on sheet name,
• Select move or copy  
▫ HINT: you need to add some data to check the copying 

perfectly
Hiding and Unhide Worksheet:
• Find how can we hide worksheet and unhide it 
Deleting Worksheet:
• Find how can we delete worksheet

MS Excel Basics (worksheets ): 
10

/12
/2

0
2

2
3

rd
 Y

ea
r D

en
t. T

ech
. D

ep
t.

24



Editing Worksheet: Rows and Columns

Columns run vertically 

MS Excel is providing columns 
From A to XFD

Rows run horizontally 

MS Excel is providing rows 
From 1 to 104876

Cell can be identified using columns and rows

What is the value of the Cell A3 ? 30
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Editing Worksheet: Select Rows and 

Columns
• To select Row

▫ Click on the raw heading

• To select a range of adjacent rows
▫ Click on the first row heading. 
▫ Drag to highlight through to the last 

row heading
• To select a range of non-adjacent rows 

▫ Click on the first row heading or range 
of rows. 

▫ Hold the Ctrl key down and continue 
highlighting additional row headings.

• To select column 
• Click on the column heading

• To select a range of adjacent columns
▫ Click on the first column heading. 
▫ Drag to highlight through to the 

last column heading

▫ To select a range of non-adjacent 
columns 

▫ Click on the first column heading 
or range of columns. 

▫ Hold the Ctrl key down and 
continue highlighting additional 
column headings
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Editing Worksheet: Modify Rows height and 

Columns width 
• To modify the Column width 

• Click on the column 
heading(s) to modify. 

• On the Home tab, in the 
Cells group, click the Format 
button. 

• To modify column width to a 
specified value, click Column 
Width and enter a width, 
then click OK. 

• To modify column width to 
optimal width, click Auto-fit 
Column Width. 

• To modify the Row height 

• Click on the row 
heading(s) to modify. 

• On the Home tab, in the 
Cells group, click the 
Format button. 

• To modify row height to a 
specified value, click Row 
Height and enter a row 
height, then click OK.

• To modify row height to 
optimal height, click Auto-
fit Row Height.

10/12/2022 3rd Year Dent. Tech. Dept. 27



Editing Worksheet: Freeze column title 

• Why ?

▫ To keep column headings visible regardless of 
where you scroll in your sheet.

• How ? 

▫ Select the column immediately to the right of 
the column to freeze. 

▫ On the View tab, in the Window group, click 
the Freeze Panes arrow. 

▫ Click the Freeze Panes button

10/12/2022 3rd Year Dent. Tech. Dept. 28



Exercise:

• Students should create their first excel sheet by
adding a table as the following and find the total
using the formula bar

Name
Marks scored in 
Computer

Marks scored in 
medical chemistry 

Total 

Mohammed 78 90
Ahmed 80 90
Omar 96 100
Ali 86 92
Mazin 49 89 10/12/2022
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Formatting Cells: Setting Cell type 

The list is showing the different types 
that cell can handle .

In order to modify the cell type, 
select the cell
And then number group in the home 
tab  

10/12/2022 3rd Year Dent. Tech. Dept. 30



• Select text,

• Modify the font type and size from Font Group

Formatting Cells: Setting fonts

10/12/2022 3rd Year Dent. Tech. Dept. 31



Formatting Cells: Text-decoration and 

setting text color  

• To get the Format Cell 
Dialog:

Right click on cell and 
select format cell , font 
tab

1. Modify font style
2. Effects

• Change the text color 

10/12/2022 3rd Year Dent. Tech. Dept. 32



• To rotate A cell:

▫ Display the same 
format cell dialog

▫ Select alignment tab

▫ Modify the 
orientation

Change the text 
alignment :

Formatting Cells: Rotate Cells 

10/12/2022 3rd Year Dent. Tech. Dept. 33



• To change the background color: 

▫ Display the format cell

▫ Go to Fill tab 

• To add borders: 

▫ Display the format cell

▫ Go to Border tab 

Formatting Cells: Setting Colors

$98.0

$98.0

10/12/2022 3rd Year Dent. Tech. Dept. 34



• Is to combine two or more cells into a single cell.

• How ? Select and merge 

Formatting Cells: Merge Cells

10/12/2022 3rd Year Dent. Tech. Dept. 35



• Problem?

• Solution :

Merge cells 

Wrap text

Shrink to fit 

Formatting Cells: Wrap text

The cell content is :
Ahmed Abdullah Ali
HOWEVER , the cell is only displaying (Ahmed A) 

Format cell dialog
Alignment Tab 
Control Text 

10/12/2022 3rd Year Dent. Tech. Dept. 36



Formatting Sheets: Options for printing purpose 

To set the layout for 
printing :
Go to page layout tab
Sheet options group

10/12/2022 3rd Year Dent. Tech. Dept. 37



• Add header and footer to add information to the 
workbook.

Formatting Sheets: add header and footer 

Page layout 
Sheet options
Header/footer  

10/12/2022 3rd Year Dent. Tech. Dept. 38



 Margins : are the unprinted area the page sides

 All margins are fixed for the same pages.

Formatting Sheets: Set Margins and page orientation

Change page 
orientation, 

1. Portrait 
2. landscape

10/12/2022 3rd Year Dent. Tech. Dept. 39



Formatting Sheets: insert page break and background 

•Page break: Identify the 
printed part of each page 

•Background for the 
entire worksheet 

•How ?

10/12/2022 3rd Year Dent. Tech. Dept. 40



Formatting Sheets: Conditional Formatting 

• enables you to format a range of values so that values 
outside certain limits, are automatically formatted.

Select the column  in which 
you want to apply the 
conditional formatting

10/12/2022 3rd Year Dent. Tech. Dept. 41



References :

• ICS skills, New Ecdl Syllabi , 2013

10/12/2022 3rd Year Dent. Tech. Dept. 42



Through this lecture students will be able to:
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Lecture - 1:  3rd Year Dent. Tech. Dept.

Microsoft Office 2019
Mainly it include the three popular 

applications
MS Office include many 

applications
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Office applications
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Microsoft applications

Microsoft applications are comprised
of mainly the Office suite of
applications that support various
productivity needs on both Microsoft
Windows and Mac OS operating
systems.

تاقیبطتةعومجمنميساسألكشبMicrosoftتاقیبطتنوكتت
Officeلیغشتةمظنأىلعةفلتخملاةیجاتنلإاتاجایتحلاامعدتيتلا:

Microsoft Windows ,Mac OS

3rd Year Dent. Tech. Dept.11/2/22 4



MS Excel Basics 
1. Identify general needed  

shortcuts
2. Explore MS excel window 
3. Navigate between 

different cells
4. Manage the workbook 
5. Formatting for cells and 

sheets (paper)

(The Excel)ةمھملاتاقیبطتلادحأبلاوأأدبن

 :نمةبلطلانكمتیس
ةٍبولطملاةماعلاتاراصتخلااةفرعم1.

Shortcut 
لسكاتفوسوركیامةذفانعملماعتلا2.
ةفلتخملاایلاخلانیبلقنتلاةیفیك3.
 Workbookفنصملاةرادإ4.
قارولأاوایلاخلاقیسنت5.
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1. Click the Start button.
2. Locate the application you want to pin     

to the taskbar and right-click on it.
3. In the menu that appears, hover your 

cursor over "More"
4. Click on "Pin to taskbar"

How to pin Microsoft Excel to taskbar?
3rd Year D
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1. Click on Microsoft Excel.
2. Select desired option

(NEW = Ctrl +N
or   OPEN= Ctrl +O )

How to start Microsoft Excel?
11/2/22

7

3rd Year D
ent. Tech. D

ept.



Keyboard Shortcuts 
q General :
v New Workbook (Ctrl+N)
v Open a Workbook (Ctrl+O)
v Save a Workbook (Ctrl+S)
v Print a Workbook  (Ctrl+P)
v Close a Workbook (Ctrl+W)
v Undo (Ctrl+Z)
v Redo (Ctrl+Y)
v Switch between apps (Alt + Tab)

q Editing:
v Cut   (Ctrl+X)
v Copy (Ctrl+C)
v Paste (Ctrl+V)

3rd Year Dent. Tech. Dept.11/2/22 8



Learning MS Excel Basics: Explore Window 
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The Ribbon

Microsoft Excel Ribbon is the
row of tabs and icons at the top
of the Excel window. It allows
you to quickly find and use
commands for completing a
certain task. It looks like a kind
of complex Toolbar.
11/2/22 103rd Year Dent. Tech. Dept.



The Home contain the following Icon
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1. Clipboard (CUT, COPY, PASTE)  
2. Font
3. Alignment  
4. Number 
5. Style
6. Cell 
7. Editing

Ribbon contain the following Icon

لاةھجاو
Home

11/2/22 123rd Year Dent. Tech. Dept.



Font (type and  size)
Style (Underline, Italics, and Bold) or (Ctrl+U), (Ctrl+I),(Ctrl+B)

Colours( fill colours)
Borders:

Font Attributes

11/2/22 133rd Year Dent. Tech. Dept.



Learning MS Excel Basics: Entering Value

This is the default sheet
To enter data: Select the cell, Start typing
Important tips:
1. To move to the next column (press Tab key)
2. To move to the next row (press Enter key)
3. To start new line in the same Column(press 

Alt + Enter) you can use the arrows key to 
select the desired cell.

cell

11/2/22 143rd Year Dent. Tech. Dept.



Saving Workbook:
• File > save as > specify the location and modify the 

file’s name if required.

Closing Workbook: CTRL+W or
CTRL+F4

Open workbook:      CTRL+O

Learning MS Excel Basics:

3rd Year Dent. Tech. Dept.11/2/22 15



For Worksheets we can:
1. Insert one or more Worksheet
2.Rename it
3.Change its Tab color
4.Rearrange them in any required order
5.Delete unrequired one
6.Duplicate (copy) or move it before / after 

any Worksheet or at the end
7.Hid and Unhide certain Worksheet.  

Managing worksheets 

11/2/22 163rd Year Dent. Tech. Dept.



MS Excel Basics 

1. Identify general needed  shortcuts

2.Explore MS excel window 

3.Navigate between different cells

4.Manage the workbook 

5. Formatting for cells and sheets
11/2/22 3rd Year Dent. Tech. Dept. 17



Getting started

11/2/22 3rd Year Dent. Tech. Dept. 18

Cell : can 
contain a 

Number, 
Logic Date,

text or 
formula

Worksheet:
a single

spreadsheet that 
contains cells
organized by 

rows and 
columns

Workbook :
Excel file that contains one 

or more 
worksheets



Saving Workbook:
•File > save as > specify the location 

and modify the file’s name if 
required.

Closing Workbook: CTRL+W

Open workbook: CTRL+O

Learning MS Excel Basics:

11/2/22 3rd Year Dent. Tech. Dept. 19



Managing worksheets 

1. Identify how to manage worksheet
2.Editing worksheets 

11/2/22 3rd Year Dent. Tech. Dept. 20



oActivate the cell and add data
o Insert formula:

Formula in Excel ( Insert data )

11/2/22 21
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Editing Worksheet:

11/2/22 3rd Year Dent. Tech. Dept. 22
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Editing Worksheet: Sorting Cells

• Sorting in ascending , descending numeric order

11/2/22 3rd Year Dent. Tech. Dept. 23



Creating new Worksheet:
• How many sheet are provided in the workbook by default?
• Now in order to add more sheets:
▫ Right-click on sheet tabs 
▫ Select Insert
▫ An insert dialog will display with selected worksheet  

Copy Worksheet:
• Right click on sheet name,
• Select move or copy  
▫ HINT: you need to add some data to check the copying 

perfectly
Hiding and Unhide Worksheet:
• Find how can we hide worksheet and unhide it 
Deleting Worksheet:
• Find how can we delete worksheet

MS Excel Basics (worksheets ): 
11/2/22
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Editing Worksheet: Rows and Columns

Columns run vertically 

MS Excel is providing columns 
From A to XFD

Rows run horizontally 

MS Excel is providing rows 
From 1 to 104876

Cell can be identified using columns and rows
What is the value of the Cell A3 ? 30

11/2/22 3rd Year Dent. Tech. Dept. 25



Editing Worksheet: Select Rows and 
Columns

• To select Row
▫ Click on the raw heading

• To select a range of adjacent rows
▫ Click on the first row heading. 
▫ Drag to highlight through to the last 

row heading
• To select a range of non-adjacent rows 
▫ Click on the first row heading or range 

of rows. 
▫ Hold the Ctrl key down and continue 

highlighting additional row headings.

• To select column 
• Click on the column heading

• To select a range of adjacent columns
▫ Click on the first column heading. 
▫ Drag to highlight through to the 

last column heading

▫ To select a range of non-adjacent 
columns 

▫ Click on the first column heading 
or range of columns. 

▫ Hold the Ctrl key down and 
continue highlighting additional 
column headings

11/2/22 3rd Year Dent. Tech. Dept. 26



Editing Worksheet: Modify Rows height and 
Columns width 

• To modify the Column width 
• Click on the column 

heading(s) to modify. 
• On the Home tab, in the 

Cells group, click the Format 
button. 

• To modify column width to a 
specified value, click Column 
Width and enter a width, 
then click OK. 

• To modify column width to 
optimal width, click Auto-fit 
Column Width. 

• To modify the Row height 

• Click on the row 
heading(s) to modify. 

• On the Home tab, in the 
Cells group, click the 
Format button. 

• To modify row height to a 
specified value, click Row 
Height and enter a row 
height, then click OK.

• To modify row height to 
optimal height, click Auto-
fit Row Height.

11/2/22 3rd Year Dent. Tech. Dept. 27



Editing Worksheet: Freeze column title 

• Why ?
▫ To keep column headings visible regardless of 

where you scroll in your sheet.
• How ? 
▫ Select the column immediately to the right of 

the column to freeze. 
▫ On the View tab, in the Window group, click 

the Freeze Panes arrow. 
▫ Click the Freeze Panes button

11/2/22 3rd Year Dent. Tech. Dept. 28



Exercise:
• Students should create their first excel sheet by

adding a table as the following and find the total
using the formula bar

Name
Marks scored in 
Computer

Marks scored in 
medical chemistry 

Total 

Mohammed 78 90
Ahmed 80 90
Omar 96 100
Ali 86 92
Mazin 49 89 11/2/22
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Formatting Cells: Setting Cell type 

The list is showing the different types 
that cell can handle .

In order to modify the cell type, 
select the cell
And then number group in the home 
tab  

11/2/22 3rd Year Dent. Tech. Dept. 30



• Select text,
• Modify the font type and size from Font Group

Formatting Cells: Setting fonts

11/2/22 3rd Year Dent. Tech. Dept. 31



Formatting Cells: Text-decoration and 
setting text color  

• To get the Format Cell 
Dialog:

Right click on cell and 
select format cell , font 
tab

1. Modify font style
2. Effects

• Change the text color 

11/2/22 3rd Year Dent. Tech. Dept. 32



• To rotate A cell:
▫ Display the same 

format cell dialog
▫ Select alignment tab
▫ Modify the 

orientation

Change the text 
alignment :

Formatting Cells: Rotate Cells 

11/2/22 3rd Year Dent. Tech. Dept. 33



• To change the background color: 
▫ Display the format cell
▫ Go to Fill tab 

• To add borders: 
▫ Display the format cell
▫ Go to Border tab 

Formatting Cells: Setting Colors

$98.0

$98.0
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• Is to combine two or more cells into a single cell.
• How ? Select and merge 

Formatting Cells: Merge Cells

11/2/22 3rd Year Dent. Tech. Dept. 35



• Problem?

• Solution :
vMerge cells 
vWrap text
vShrink to fit 

Formatting Cells: Wrap text

The cell content is :
Ahmed Abdullah Ali
HOWEVER , the cell is only displaying (Ahmed A) 

Format cell dialog
Alignment Tab 
Control Text 

11/2/22 3rd Year Dent. Tech. Dept. 36



Formatting Sheets: Options for printing purpose 

To set the layout for 
printing :
Go to page layout tab
Sheet options group

11/2/22 3rd Year Dent. Tech. Dept. 37



• Add header and footer to add information to the 
workbook.

Formatting Sheets: add header and footer 

Page layout 
Sheet options
Header/footer  

11/2/22 3rd Year Dent. Tech. Dept. 38



§ Margins : are the unprinted area the page sides
§ All margins are fixed for the same pages.

Formatting Sheets: Set Margins and page orientation

Change page 
orientation, 

1. Portrait 
2. landscape

11/2/22 3rd Year Dent. Tech. Dept. 39



Formatting Sheets: insert page break and background 

•Page break: Identify the 
printed part of each page 

•Background for the 
entire worksheet 

•How ?
11/2/22 3rd Year Dent. Tech. Dept. 40



Formatting Sheets: Conditional Formatting 

• enables you to format a range of values so that values 
outside certain limits, are automatically formatted.

Select the column  in which 
you want to apply the 
conditional formatting

11/2/22 3rd Year Dent. Tech. Dept. 41
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• ICS skills, New Ecdl Syllabi , 2013
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Learning	MS	Excel	Basics:	Explore	Window	
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Status	Bar
Displays	the	current	cell	mode,	One	of	the	following	modes	is	displayed:

1. Ready to	indicate	a	general	state.

2. Enter to	indicate	content	entry	mode.	It	is	displayed	when	you	select	a	

cell	and	start	typing,	or	when	you	press	F2	twice.

3. Edit to	indicate	in-cell	editing	mode.	It	is	displayed	when	you	double-click

a	cell,	or	when	you	press	F2 so	that	you	can	enter	or	edit	data	in	a	cell.

4. Point to	indicate	formula	cell	selection	mode.	It	is	displayed	when	you	start	a	

formula and	then	click	the	cells that	you	want	to	include	in	the	formula.
3rd Year Dent. Tech. Dept11/2/22
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Cells	Navigation	(EXCEL	Sheet		Boundary)

3rd Year Dent. Tech. Dept11/2/22 3



Total	number	of	Cells

3rd Year Dent. Tech. Dept11/2/22
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seventeen	billion	one	hundred	seventy-nine	million	eight	hundred	sixty-nine	thousand	one	hundred	eighty-four)



Types	of	Data	in	Excel	Cell
Cell	can	contains	the	following	types	of	Data:

1. Number:	it	could	be	Decimal	and/or	comma	separator..

2. Date:	user	can	select	any	Date	format	(Hijri,	Gregorian).

3. Text:	All	types		(	Char,	Number	and	special	characters)

4. Formula: Date	&	Time,	Statistical,	Math	&	trig,	Logical	…(Shift+F3)

5. Errors: #DIV/0,	#N/A,	#NAME?,	#NULL!,	#NUM!,	#REF!,	#VALUE!,	#####

3rd Year Dent. Tech. Dept11/2/22
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6How	to	add	Comment

3rd Year Dent. Tech. Dept

11/2/226
1. At	any	cell	,right	click	(mouse)		then	
2. Select	(Insert	Comment)	the	

following	picture	appear.
3. Put	the	cursor	at	the			boundary.
4.	Right	click	(	mouse)
5.	Select	(Format	Comment)



7How	to	add	Picture

11/2/22 7

5.	Select	(Colors	&	Lines)
6.	Select	fill	effect

3rd Year Dent. Tech. Dept



8How	to	add	Picture

3rd Year Dent. Tech. Dept11/2/22

7.	Select	Picture



9How	to	add	Validation

3rd Year Dent. Tech. Dept11/2/22 9

1. From	Data	at	Ribbon	select	(Data	Validation)
2. Select		Setting	=>Any	Value
3. Select	the	appropriate	type	(Number,	Date,	Decimal,…
4. Below	a	selection	of	Date	type



10How	to	add	input	Message	in	Validation	

3rd Year Dent. Tech. Dept11/2/22 10

1. From	Data	Validation		select	(Input	Message)
2. Type	the	Tittle	and	your	Help	message
3. Press	OK…



11Types	of	Error	Alert	in	Validation	

3rd Year Dent. Tech. Dept11/2/22 11

1.	STOP 2.	Warning 3.	Information



12Past	Special

3rd Year Dent. Tech. Dept

11/2/22 12
1.Copy	the	source	cell	or	a	range	of	cells.	
2.Open	the Paste	Special dialog.
3.Select	the	desired	paste	option,	and
4. click	OK	or	press	the Enter key



Excel functions
Types of operations Order of PrecedenceTypes (by category)



1How	to	add	Validation

3rd Year Dent. Tech. Dept11/2/22 1

1. From	Data	at	Ribbon	select	(Data	Validation)
2. Select		Setting	=>Any	Value
3. Select	the	appropriate	type	(Number,	Date,	Decimal,…
4. Below	a	selection	of	Date	type



2How	to	add	input	Message	in	Validation	

3rd Year Dent. Tech. Dept11/2/22 2

1. From	Data	Validation		select	(Input	Message)
2. Type	the	Tittle	and	your	Help	message
3. Press	OK…



3Types	of	Error	Alert	in	Validation	

3rd Year Dent. Tech. Dept11/2/22 3

1.	STOP 2.	Warning 3.	Information



Example-1	of	Circle	Invalid	Data3rd Year Dent. Tech. Dept

11/2/22

4

ةساردلا عون لقح يف أطخلا رشأ



Example-2	of	Circle	Invalid	Data
Circle	all		incorrect	study	type

3rd Year Dent. Tech. Dept

11/2/22

5



• From	main	menu	select	data	

• Then	Data	Validation										

• Then	Circle	invalid	Data

Steps	to	circle	invalid	Data		  ددح ،ةیسیئرلا ةمئاقلا نم
تانایبلا

3rd Year Dent. Tech. Dept
11/2/22 6



Solve	Homework	Assignment

HW:	Calculate	your	age	in	Years,	Months	and	Days.
Method	– One	(	Using	built-in	Integer	command	INT)
Sol:
1. Age	in	days	(C1)	=	current	date	(A1)	– Birthdate	(B1)=	;	current	date	TODAY().
2. Take	integer	value	of	C1/365		;				D1=	INT(C1/365)	;	#	of	Years.
3. Let	E1	=	C1	– 365	*	D1	;	Fractions	of	days/year.
4. Let	F1	=I	NT(E1/30)	;	#	of	Months.
5. #		of	days	(G1)	=	E1	– 30	*	F1

3rd Year Dent. Tech. Dept
11/2/22 7



Solve	Homework	Assignment
Method	– Two	(	Using	built-in	Date&Time command	DATEIF)
Syntax:	 DATEDIF(start_date,	end_date,	unit)	;		Where:
start_date=	Date	of	birth(P2)	;
end_date(P3)=	current	date	TODAY();
Unit=	“Y”	return	total	number	of	complete	Years	in	the	period.
Unit=	“YM”	return	total	number	of	complete	Months	in	the	period.
Unit=	“MD”	return		the	number	of	Days	in	the	period.
Sol:		If	P3	=	7/14/1996,	then	
DATEDIF(P2,	P3,	“Y”);		gives				26	Years		(P5);												
DATEDIF(P2,	P3,	“YM”);		gives	3	Months	and	(P6)
DATEDIF(B2,	P3,	“MD”);		gives	16	Days	(P7).

we	can	use	concat built-in	function (@)	to		merge	above	functions,	we	get:

=P5&"	Years,	"&P6&"	Months,	and	"&P7&"	days"

3rd Year D
ent. Tech. D

ept
11/2/228

Compare	the	
results	of	both	

methods,



Next Lecture (Excel functions)
Types of operations Order of PrecedenceTypes (by category)
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3rd Year / Dent. Tech. Department
2022-2023       /     (Lecture – 5&6)
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Order of operators Precedence
1. ( ^ ) Exponential
2. ( /,*) Division and  Multiplication

3. ( +,- ) Addition and Subtraction
4. ( & )Concatenation
5. ( =,>,< ,<=,>=,<>) Relational operators 
Any operators inside Parentheses ( ) 
(round brackets) must be  evaluated 
first then this rule applied.

ن، 
لإثني

ا
1
3

ربيع
ي، 

الثان
1
4
4
4

3rd Year Dent. Tech. Dept 2



Function and Formula in Excel
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Function and Formula in Excel

1. Shift+F3 (search for function)
2. From Formula Tab
3. Argument could be (zero,1,2,…n)
4. Insert from current sheet or another one

3rd Year Dent. Tech. Dept11/7/2022 4



How to Edit  Function

3rd Year Dent. Tech. Dept11/7/2022 5

1. Double click the cell that contains the data that you want to edit.

2. Click the cell that contains the data that you want to edit, and then 

press F2.

3. Click the cell that contains the data that you want to edit, and then 

click anywhere in the formula bar



Three types of cell Address:
1. Relative (address change in relation of 

cell position)

2. Absolut ($ sign) lock the cell, no change.

3. Mixed (Partially Absolute)

Types of  Cell Address

3rd Year Dent. Tech. Dept11/7/2022 6



What is a range reference in Excel?

Cell Reference

When copied and filled to other cells, relative and absolute 
references behave differently

73rd Year Dent. Tech. Dept11/7/2022



The dollar sign ($) is used to make references absolute.
it has three different states :

Cell Reference

8
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FORMULA in EXCEL

3rd Year Dent. Tech. Dept11/7/2022 10

Argument could be 
(zero,1,2,…n) elements.
Argument is the material  

between the two 
brackets () after the 
function name.



Argument in EXCEL

3rd Year Dent. Tech. Dept11/7/2022 11

Example:
Today() … Zero argument.
NOT(TRUE)….One single Argument
SUM(1,2,4,10)        (n) Arguments
SUM(A1:A10,B5:B12)
IF(logical_test,[value_if_true],[value_if_false])

Up to 64 nested if
Most arguments are required, but some are optional. In Excel, optional 

arguments are denoted with square brackets

{  } for array

Control + Shift + Enter



AND
OR / XOR

NOT
TRUE
FALSE

IF
IFS

IFERROR
IS

Lo
gical FU

N
C

TIO
N

M
ath

 FU
N

C
TIO

N

INT
MOD
RAND

RANDBETWEEN
ROUND

SUM
SUMIF

SUMPRODUCT

3rd Year Dent. Tech. Dept11/7/2022 12

FUNCTION CATEGORY 



AND, OR,NOT & XOR 3rd Year Dent. Tech. Dept11/7/2022
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Math FUNCTION

3rd Year Dent. Tech. Dept11/7/2022 15





Math FUNCTION

3rd Year Dent. Tech. Dept11/7/2022 17





STATISTICAL FUNCTIONS

6. AVERAGE

7. AVERAGEIF                            

8. AVERAGEIFS                

1.COUNT
2.COUNTA
3.COUNTBLANK                                             
4. COUNTIF
5. COUNTIFS

9.LARGE
10.SMALL
11.MIN      
12.MAX                                                                              
13.RANK                                                                              

3rd Year Dent. Tech. Dept11/7/2022 19

14.MINIFS 

15.MAXIFS

16.MEDIAN

17. MODE 

18.STANDARD DEVIATION





IS FORMULA in EXCEL 3rd Year Dent. Tech. Dept11/7/2022 21

ISBLANK()
ISERROR()
ISNA()
ISNUMBER()
ISODD()
ISEVEN()

ISTEXT()

Check if the value is BLANK

Check if the value is ERROR

Check if the value is #N/A

Check if the value is NUMBER

Check if the value is ODD

Check if the value is EVEN

Check if the value is TEXT



IS FORMULA in EXCEL 3rd Year Dent. Tech. Dept11/7/2022 22

ISNONTEXT()

ISERR()

ISREF()
ISOWEEKNUM)
ISFORMULA()

Check if the value is not a text

Returns TRUE if the given value is an error (except 
N/A) and vice versa

Check if the value is #N/A

Check if the value is NUMBER

Check if the value is ODD



IFERROR (value, value_if_error)11/7/2022 23

IFERROR checks a formula, and if it evaluates to an 
error, returns another value you specify; otherwise, 
returns the result of the formula.
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Example of ISNA Function

3rd Year Dent. Tech. Dept11/7/2022
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3rd	Year	/	Dent. Tech. Department
2022-2023							/					(Lecture	– 5&6)TYPES	OF	EXCEL	

FUNCTION	
3rd Year Dent. Tech. Dept11/14/22 1



Order of operators Precedence
1. (	^	)	Exponential
2. (	/,*)	Division	and		Multiplication
3. (	+,- )	Addition	and	Subtraction
4. ( & )Concatenation
5. (	=,>,<	,<=,>=,<>)	Relational operators 
Any	operators	inside	Parentheses	(	)	
(round	brackets)	must	be		evaluated	
first	then	this	rule	applied.

لإا
ینث

 ،ن
20

یبر
لاع

ناث
 ،ي

1444
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Function and Formula in Excel
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Function and Formula in Excel

1. Shift+F3	(search	for	function)
2. From	Formula	Tab
3. Argument	could	be	(zero,1,2,…n)
4. Insert	from	current	sheet	or	another	one

3rd Year Dent. Tech. Dept11/14/22 4



How to Edit  Function

3rd Year Dent. Tech. Dept11/14/22 5

1. Double	click	the	cell	that	contains	the	data	that	you	want	to	edit.

2. Click	the	cell	that	contains	the	data	that	you	want	to	edit,	and	then	

press	F2.

3. Click	the	cell	that	contains	the	data	that	you	want	to	edit,	and	then	

click	anywhere	in	the	formula	bar



Three	types	of	cell	Address:
1. Relative (address change in relation of 

cell position)
2. Absolut ($	sign)	lock	the	cell,	no	change.

3. Mixed	(Partially	Absolute)

Types of  Cell Address

3rd Year Dent. Tech. Dept11/14/22 6



What	is	a	range	reference	in	Excel?
Cell Reference

When	copied	and	filled	to	other	cells,	relative	and	absolute	
references	behave	differently

73rd Year Dent. Tech. Dept11/14/22



The dollar sign ($) is used to make references absolute.
it has three different states :

Cell Reference

8
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FORMULA	in	EXCEL

3rd Year Dent. Tech. Dept11/14/22 10

Argument	could	be	
(zero,1,2,…n)	elements.
Argument	is	the	material		
between	the	two	
brackets	()	after	the	
function	name.



Argument	in	EXCEL

3rd Year Dent. Tech. Dept11/14/22 11

Example:
Today()	…	Zero	argument.
NOT(TRUE)….One	single	Argument
SUM(1,2,4,10)								(n)	Arguments
SUM(A1:A10,B5:B12)
IF(logical_test,[value_if_true],[value_if_false])

Up	to	64	nested	if
Most	arguments	are	required,	but	some	are	optional.	In	Excel,	optional	
arguments	are	denoted	with	square	brackets

{		} for	array
Control	+	Shift	+	Enter



AND
OR	/	XOR
NOT
TRUE
FALSE
IF
IFS

IFERROR
IS

Logical	FU
N
CTIO

N

M
ath	FU

N
CTIO

N

INT
MOD
RAND

RANDBETWEEN
ROUND
SUM
SUMIF

SUMPRODUCT
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FUNCTION CATEGORY 



AND, OR,NOT & XOR 3rd Year Dent. Tech. Dept11/14/22
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AND: Returns TRUE if ALL argument is TRUE.
A single AND function can test up to 255.
OR: Returns TRUE if any argument is TRUE
NOT : Reverses the logic of its argument.
XOR: Returns TRUE if the number of TRUE inputs is even.
IF: make logical comparisons between a value and what
you expect. IF statement can have two results. The first
result is: if your comparison is True, the second if your
comparison is False.

AND, OR,NOT,XOR & IF Functions

3rd Year Dent. Tech. Dept

11/14/22
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IF Functions (Single Condition)

3rd Year Dent. Tech. Dept 11/14/22
16

Begin

Read	variable	
A1

If(A1>=50)
PASSFAIL

End

TRUEFALSE



Ex:
test if DEPTCODE in (D1)= "ص" PRINT نانسا.ص ,

if (D1)= "م" PRINT تاربتخم ,
if (D1)= "ت" PRINT ریدخت ,
if (D1)= "ب" PRINT تایرصب ,

ELSE
PRINT مسقلا زمر نم دكأت

Format	of	Nested	IF	statement	

3rd Year Dent. Tech. Dept

11/14/2217

IF(condition1, result1, IF(condition2, result2, IF(condition3, result3, result4)))

Test condition1, if TRUE - return result1, if FALSE -
test condition2, if TRUE - return result2, if FALSE -
test condition3, if TRUE - return result3, if FALSE -
return result4



Format	of	Nested	IF	statement	
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بطت
قی

لمع
ي

=IF(D1=
“ ص" ," نانسا.ص

",IF(D1
= "م" ,"

تاربتخم ",IF(D1
= "ت" ," دخت

ری ",IF(D1
= "ب" ,"

تایرصب ","
مسقلا زمر نم دكأت
"))))



: عبطل ةلاد ةباتكل هاندا لودجلا مدختسا
)B2=X وA2=F اذإ( ةبئاغ1.
)B2=A وA2=F اذإ( ةرضاح2.
)B2=X وA2=T اذإ(بئاغ3.
)B2=A وA2=T اذإ( رضاح4.

Combine	IF	statement	with	AND	&	OR	

3rd Year Dent. Tech. Dept 11/14/22
20

سنجلا A روضحلا B

F X

F A

T X

T A

عبطی
ةبئاغ
ةرضاح
بئاـغ
رضاـح

1
1
3

4



Example	of	using	IF	statement	with	AND

3rd Year Dent. Tech. Dept 11/14/22
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Math	FUNCTION
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Math	FUNCTION

3rd Year Dent. Tech. Dept11/14/22 23
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STATISTICAL	FUNCTIONS

6. AVERAGE

7. AVERAGEIF																												

8. AVERAGEIFS																

1.COUNT
2.COUNTA
3.COUNTBLANK																																													
4. COUNTIF
5. COUNTIFS

9.LARGE
10.SMALL
11.MIN						
12.MAX																																																																														
13.RANK																																																																														

3rd Year Dent. Tech. Dept11/14/22 25

14.MINIFS	

15.MAXIFS

16.MEDIAN

17. MODE	

18.STANDARD	DEVIATION
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IS FORMULA	in	EXCEL 3rd Year Dent. Tech. Dept11/14/22 27

ISBLANK()
ISERROR()
ISNA()
ISNUMBER()
ISODD()
ISEVEN()

ISTEXT()

Check	if	the	value	is	BLANK

Check	if	the	value	is	ERROR

Check	if	the	value	is	#N/A

Check	if	the	value	is	NUMBER

Check	if	the	value	is	ODD

Check	if	the	value	is	EVEN

Check	if	the	value	is	TEXT



IS FORMULA	in	EXCEL 3rd Year Dent. Tech. Dept11/14/22 28

ISNONTEXT()

ISERR()

ISREF()

ISOWEEKNUM()

ISFORMULA()

Check	if	the	value	is	not	a	text

Returns	TRUE	if	the	given	value	is	an	error	(except	
N/A)	and	vice	versa

Check	if	the	value	is	a	reference	or	not

Return	the	ISO	week	number	of	the	
year	for	the	given	date	value

checks	to	see	if	a	value	is	a	formula



IFERROR (value,	value_if_error)11/14/22 29

IFERROR	checks	a	formula,	and	if	it	evaluates	to	an	
error,	returns	another	value	you	specify;	otherwise,	
returns	the	result	of	the	formula.

3rd Year D
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Example of ISNA Function
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30



بطت
قی

لمع
ي



3rd Year Dent. Tech. Deptrtment

3rd Year Dent. Tech. Deptrtment12/5/2022 1

We can combine more than one 
logical function in a formula like:          
     [ IF with  AND, OR and not NOT]  

12/5/2022 1



Format of Nested IF statement 

3rd Year Dent. Tech. Deptrtment12/5/2022
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IFS statement instead of  Nested IF statements 

3rd Year Dent. Tech. Deptrtment12/5/2022
3

= IFS(D1=“ب”, ”بصریات”, 
         D1=“س”,”أ. وسونار”, 
         D1=“م”, ”مختبرات” ,
         D1=“ت”, ” تخدیر” ,
             TRUE,”تأكد من الرمز”)

ONLY in Excel 2019 and above

Use your Mobil to add abbreviations to all Alnoor Departments 
= IFS(D1=“ب”, ”بصریات”, D1=“س”,”أ. وسونار”, D1=“م”,”مختبرات”, D1=“ت”,” تخدیر”, TRUE,”تأكد من 
(”الرمز



تطبیق عملي
=IF(D1=““وسونار 

مختبرات"=IF(D1, "س,"إ.
ت",""=IF(D1 ,"م","

مز القسم"=IF(D1,"تخدیر
"تأكد من ر

صریات",
(((("ب","ب

4
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1. INT() 6. ROUNDDOWN()

2. RAND() 7. MROUND()

3. MOD() 8. CEILING()

4. ROUND() 9. FLOOR()

5. ROUNDUP() 10. RANDBETWEEN()

Math FUNCTION (part-1) [Ten Functions]

12/5/2022

3rd Year Dent. Tech. Deptrtment

5

Each 
function has 

its own 
argument 

(number of 
parameters)



تطبیق عملي
3rd Year Dent. Tech. Deptrtment 6



INT() , MOD() FUNCTIONS

12/5/2022 3rd Year Dent. Tech. Deptrtment 7

 WHAT IS:
 INT(-8.45) ,

           INT(PI()) 



               RAND()  FUNCTION

12/5/2022 3rd Year Dent. Tech. Deptrtment 8



RANDBETWEEN()  FUNCTION

12/5/2022 3rd Year Dent. Tech. Deptrtment 9



ROUND()  FUNCTION

12/5/2022 3rd Year Dent. Tech. Deptrtment 10

=ROUND(148.55,-2)=?



ROUNDUP()  FUNCTION

12/5/2022 3rd Year Dent. Tech. Deptrtment 11

Syntax:
ROUNDUP(N, digits)
•ROUNDUP behaves like ROUND, except that it always rounds a 
number up.
• If digits is greater than zero, then number is rounded up to the  

specified number of decimal places.
• If digits is 0, then number is rounded up to the nearest integer.
• If digits is less than 0, then number is rounded up to the left of the 

decimal point.

=ROUNDUP(7815.75431, -2)    GIVES 7900



ROUNDUP()  FUNCTION Examples 12/5/2022
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ROUNDDOWN()  FUNCTION

12/5/2022 3rd Year Dent. Tech. Deptrtment 13

=ROUNDDOWN(7815.75431, -2) GIVES 7800



MROUND()  FUNCTION

12/5/2022 3rd Year Dent. Tech. Deptrtment 14

=MROUND(7815.75431, -2) GIVES 7800

=MROUND(17,5) GIVES 15
=MROUND(18,5) GIVES 20
MROUND(pi(),2) GIVES 4

What is the result of:
     =MROUND(25.4,3)
     =MROUND(25.6,3)



CEILING()  FUNCTION

12/5/2022 3rd Year Dent. Tech. Deptrtment 15

=CEILING(16.999,1) GIVES 17

What is the result of:
     =CEILING (25.4,3)
     =CEILING (pi(),1)
    =CEILING (pi(),2)
    =CEILING (pi(),4)
    =CEILING(PI(),7)

=CEILING(16.001,1) Gives 17
=CEILING(16.001,2) Gives 18
=CEILING(16.001,3) Gives 18
=CEILING(16.001,4) Gives 20



FLOOR()  FUNCTION

12/5/2022 3rd Year Dent. Tech. Deptrtment
16

=FLOOR(16.999,1) GIVES 16

 What is the result of:
   =FLOOR(25.4,1)

   =FLOOR(25.4,2)

   =FLOOR(25.4,3)

   =FLOOR(25.4,7)

Syntax
FLOOR(number, significance)

Formula Result
 FLOOR(42.001,1) 42
 FLOOR(42.999,1) 42
 FLOOR(pi(),1) 3



3rd Year Dent. Tech. Department
2022-2023       /     (Lecture – 9)
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IFERROR function, to handle errors in a formula.



IFERROR (value, value_if_error)

IFERROR checks a formula, and if it evaluates to an 
error, returns another value you specify; otherwise, returns 
the result of the formula.

Syntax

IFERROR(value, value_if_error)
value : The argument that is checked for an error.
value_if_error: The value to return if the formula 

evaluates to an error.
12/11/2022 3rd Year Dent. Tech. Department 2



Math FUNCTION (Part – Two)

3rd Year Dent. Tech. Department12/11/2022 3





STATISTICAL FUNCTIONS (Lect. 10)

6. AVERAGE

7. AVERAGEIF                            

8. AVERAGEIFS                

1.COUNT
2.COUNTA
3.COUNTBLANK                                             
4. COUNTIF
5. COUNTIFS

9.LARGE
10.SMALL
11.MIN      
12.MAX                                                                              
13.RANK                                                                              

3rd Year Dent. Tech. Department12/11/2022 5

14.MINIFS 

15.MAXIFS

16.MEDIAN

17. MODE 

18.STANDARD DEVIATION





Information Function :    IS FORMULA in EXCEL (Lect-11)

3rd Year Dent. Tech. Department12/11/2022 7

ISBLANK()
ISERROR()
ISNA()
ISNUMBER()
ISODD()
ISEVEN()

ISTEXT()

Check if the value is BLANK

Check if the value is ERROR

Check if the value is #N/A

Check if the value is NUMBER

Check if the value is ODD

Check if the value is EVEN

Check if the value is TEXT



ISNONTEXT()

ISERR()

ISREF()

ISFORMULA()

Information Function :    IS FORMULA in EXCEL – Cont…

3rd Year Dent. Tech. Department
12/11/2022

8

Check if the value is not a text

Returns TRUE if the given value is an error (except 
N/A) . Otherwise, it will return FALSE.

If value is a reference, it will return TRUE. Otherwise, 
it will return FALSE.

Checks whether there is a reference to a cell that 
contains a formula, and returns TRUE or FALSE.





STATISTICAL FUNCTIONS

12/18/2022 3rd Year Dent. Tech. Department 1

3rd Year Dent. Tech. Department
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STATISTICAL FUNCTIONS (Lect. 10)

6. AVERAGE

7. AVERAGEIF                            

8. AVERAGEIFS                

1.COUNT
2.COUNTA
3.COUNTBLANK                                             
4. COUNTIF
5. COUNTIFS

9.LARGE
10.SMALL
11.MIN      
12.MAX                                                                              
13.RANK                                                                              

14.MINIFS 

15.MAXIFS

16.MEDIAN

17. MODE 

18.STANDARD DEVIATION

12/18/2022 3rd Year Dent. Tech. Department 2



COUNT functions
COUNT function counts cells that contain only numbers, but
COUNTA function counts cells that are not blank, including numbers. 

Date and Time values are stored as serial numbers in Excel so 
these values are counted in both of these functions.

COUNT function does not count logical values (TRUE and FALSE), but
COUNTA function counts these values.
COUNTBLANK function counts the number of empty cells in a range of cells.

Syntax:
COUNT/A/BLANK( range)
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COUNTIF function counts the # of cells that meet ONLY ONE criterion.
COUNTIFS function  applies criteria to cells across multiple ranges

and counts the number of times all criteria are met.

Syntax
COUNTIF(criteria range, criteria)
COUNTIFS(criteria range1, criteria1,[criteria range2, criteria2,]…)
COUNTIF(D2:D161,"M")            73                                  عدد الطلاب

COUNTIF(D2:D161, ”F”)            87                               عدد  الطالبات

COUNTIFS(H2:H161,”بغداد”,D2:D161,"F") 14عدد طالبات بغداد 

COUNTIF/S functions
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AVERAGE returns the average (arithmetic Mean) of the arguments.

AVERAGEIF calculates the average of a range based on true or 
false condition ONLY ONE criteria.

AVERAGEIFS calculates the average of a range based on one or 
more true or false condition.

Syntax: AVERAGE(range)
AVERAGEIF(criteria range, criteria, sum range)
AVERAGEIFS(sum range ,criteria range1, criteria1,[criteria    

range2, criteria2],…)

AVERAGE  functions
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LARGE Returns the Kth largest value in a data set.
SMALL Returns  the kth smallest value in a data set.
If array is empty, LARGE/SMALL returns the #NUM! error value.
If k ≤ 0 or if k > n  greater than the number of data points, LARGE/SMALL
returns the #NUM! error value.
Syntax : LARGE/ SMALL(array, k)
If n is the number of data points in a range, then LARGE(array,1) returns 
the largest value, and LARGE(array, n) returns the smallest value.
If n is the number of data points in array, SMALL(array,1) equals the 
smallest value, and SMALL(array, n) equals the largest value.

LARGE & SMALL  functions
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Information Function :    IS FORMULA in EXCEL (Lect-11)

ISBLANK()
ISERROR()
ISNA()
ISNUMBER()
ISODD()
ISEVEN()

ISTEXT()

Check if the value is BLANK

Check if the value is ERROR

Check if the value is #N/A

Check if the value is NUMBER

Check if the value is ODD

Check if the value is EVEN

Check if the value is TEXT
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ISNONTEXT()

ISERR()

ISREF()

ISFORMULA()

Information Function :    IS FORMULA in EXCEL – Cont…
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Check if the value is not a text

Returns TRUE if the given value is an error (except 
N/A) . Otherwise, it will return FALSE.

If value is a reference, it will return TRUE. Otherwise, 
it will return FALSE.

Checks whether there is a reference to a cell that 
contains a formula, and returns TRUE or FALSE.
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Information Function
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Information Function :    IS FORMULA in EXCEL (Lect-12)               

ISBLANK()
ISERROR()
ISNA()
ISNUMBER()
ISODD()
ISEVEN()

ISTEXT()

Check if the value is BLANK

Check if the value is ERROR

Check if the value is #N/A

Check if the value is NUMBER

Check if the value is ODD

Check if the value is EVEN

Check if the value is TEXT
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   ISNONTEXT()
ISERR()

   ISREF()

ISFORMULA()

…Information Function :    IS FORMULA in EXCEL – Cont
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Check if the value is not a text
 Returns TRUE if the given value is an error
.(except N/A) . Otherwise, it will return FALSE

 If value is a reference, it will return TRUE.
.Otherwise, it will return FALSE

 Checks whether there is a reference to a cell that
.contains a formula, and returns TRUE or FALSE
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Excel stores dates in a serial date format. It represents the days from January 1, 
1900. So January 1, 1900 would be the serial number 1 and January 1, 2023 would 
be 44927, as it is 44927 days after January 1, 1900.
ISOWEEKNUM():used for finding out the ISO week number of the year for the 
given date value (e.g.: ISOWEEKNUM(30) gives week number 5 of 52 weeks in 
the year).

   ISLOGICAL()

…Information Function :    IS FORMULA in EXCEL – Cont
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 Returns TRUE when a cell contains the logical
 values TRUE or FALSE, and returns FALSE for
.cells that contain any other value

ISOWEEKNUM()  Returns number of the ISO week number of
.the year for a given date
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